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How to Guide – ProcessForce Item 

Details 

The Item Details form is used to define the product 

master data associated with an item. ProcessForce 

provides a possibility to set an extended and diverse 

product definition. Item details make a number of 

item-associated activities easier, e.g. creating 

ingredient and allergen declaration, tracing batches, 

attaching files. 

Item Details record is being created automatically 

when creating Item Master Data. If an Item Master 

Data was created before ProcessForce installation, 

restore procedure must be performed to obtain 

Item Details to the Item Master Data. You can check 

how to do this here. 

 

On this page 

 Introduction 

 Revisions 

o Is MRP Default 

o Is Costing Default 

 Batch Details 

 Properties 

 Classifications 

 Phrases 

 Origins 

 Groups 

 Texts 

 Attachments 

 

 

Related pages 

 Item Master Data Setup 

 Batch Template, Serial Template Definition 

 Properties 

 Item Classifications 

 Phrases 

 Item Groups 

 Item Texts 

 MSDS, Labels and Documentation 

 Substitute Items 

 Yield Master Data 

 Country of Origin 

 

Path 

Stock Management > Item Details 



 

2.1 Introduction 

The Item Details form is used to define the master data associated with an item. 

These data elements include the following: 

 Revisions; to define valid to and from dates 

 Batch Details; to choose batch template or serial template and define 

expiry/consume date and shelf life/inspection interval 

 Properties; to define properties for example physical, chemical definitions, 

and nutritional details 

 Classification; to categorize products for example toxic, non-toxic, hazard and 

non-hazard 

 Phrases; to define for example EU phrases as part of MSDS, covering for 

example safety, hazard, and clean-up 

 Groups; to group similar products together example acids and solvents 

 Text ; to define for example hazard instructions, safety text and cleaning 

information in case of a product spillage 

 Item Property Reference Library; to define the valid values of a property for 

example color; white, black, blue 

 Attachments, to reference for example MSDS, work instructions, safety 

sheets, production videos 

All of the above forms, except the Item Reference Library contain tick boxes for 

production orders, shipment documentation; pick lists, MSDS, purchase orders, 

returns and other. 

These relationships not only document within the system, where these data 

elements are intended to be used, but also can be used as a reference when 

building reports and documents. 



 

 

↑ Top 

2.2 Revisions 

This form allows the user to define and record the revisions of an item. 

Revisions are used to record the product life cycle of a parent and item within a 

Bill of Materials. Revisions can be used to vary product structure for the same 

product. 

Revisions can be entered for the following documents: 

 Sales Orders 

 Manufacturing Orders 

 Test Protocols and Quality Control Tests 

 Complaints 

 Item Costing 

 Additional Batch Details 

Revisions are not visible within Inventory. 



 

2.2.1 Is MRP Default 

The field “Is MRP Default” is defined within the Bill of Materials form, to define 
which revision is the default for MRP planning purposes. 

If "Is MRP Default" is grayed out please create Bill of Materials with required Item 

Code and Revision. 

 

 



 

Reload Item Details form: 

 

ProcessForce revisions behave in the same manner as SAP 

 if both dates are empty – revision is valid all the time 

 if Valid From date is set up – revision is valid from this data 

 if Valid To date is set up – revision is valid to this date 

 if both dates are set up – revision is valid between these dates 

Four different statuses may be assigned to one revision: 

 Active – revision is set and ready to work with 

 Being Phased Out – is being prepared and is not ready to used 

 Engineering – is ready but waiting to be accepted 

 Obsolete – is not in use any more 

2.2.2 Is Costing Default 

This setting is relevant only for Items with Standard Valuation method and is 

used for Cost Roll-Over. When you perform Cost Roll-Over on an Item with 

Standard Valuation method on Revision that has Is Costing Default checkbox 

checked, Stock Revaluation is created on a price change. 

↑ Top 



 

2.3 Batch Details 

Yellow arrow navigates to: 

 Administration → Setup → Stock Management → Batch Template Definition 

 Administration → Setup → Stock Management → Serial Template Definition 

This form allows the user to choose batch or serial template for item. The user 

can select template from list or inherit from Item Group. 

The user can also define expiry date or consume by date (or inherit from item 

group). If a user defines expiry date or consume by date, can also define amount 

of the days prior warning. This prior warning data is used within an Alert query to 

notify those batches that are arriving to their expiry date. 

When creating a batch record, the expiry date is auto-calculated based on the 

shelf life interval. 

Batch Queue Type and Default Batch / Quality Control Status for SAP / 

ProcessForce Receipt Documents options are available to set in Batches tab, in 

Item Details form. Default batch and quality control status can be set for SAP B1 

and ProcessForce receipt documents. 

The Inspection date is also auto-calculated for the batch, and is displayed within 

Batch Master Data form (see below) 

 



 

 

To get more information on this subject click here. 

↑ Top 

2.4 Properties 

Yellow arrow navigates to: 

 Administration → Setup → Item Details → Prop Item Property Groups 

 Administration → Setup → Item Details → Property Reference Library 

This form allows the user to add and remove properties for the item master. 

Properties define physical and chemical characteristics. 

The user can select from a number of expressions to record for example a 

specific value or a from/to value dependent upon the expression. 



 

 

↑ Top 

2.5 Classifications 

Yellow arrow navigates to: 

 Administration → Setup → Item Details → Item Classifications 

This form allows the user to add and delete classification codes for the item 

master. Classifications categorize products, e.g. as toxic or non-toxic. By 

checking required checkbox classification can be connected to the certain kinds 

of document. 



 

 

↑ Top 

2.6 Phrases 

Yellow arrow navigates to: 

 Administration → Setup → Item Details → Item Phrases refer to safety or risk 

phrases used to create Material safety data sheet. By checking required 

checkbox phrases can be connected to the certain kinds of document. 

 

↑ Top 



 

2.7 Origins 

Country of Origin is the country of manufacture, production, or growth where the 

product comes from, and is used extensively to support Country of Origin 

labeling (COOL) , traceability and specific ingredients in a Customers recipe. 

Click here to find out more. 

 

↑ Top 

2.8 Groups 

Yellow arrow navigates to: 

 Administration → Setup → Item Details → Item Groups 

This form allows the user to add and delete groups for the item master. Group 

describe similar products, e.g. acids. By checking required checkbox groups can 

be connected to the certain kinds of document. 



 

 

↑ Top 

2.9 Texts 

Yellow arrow navigates to: 

 Administration → Setup → Item Details → Item Texts 

This form allows the user to add and delete item text for the item master. Any text 

may be added, e.g. hazard instructions, safety texts. By checking required 

checkbox texts can be connected to the certain kinds of document. 

 

↑ Top 



 

2.10 Attachments 

This form allows the user to attach documents to the item master. 

This operates in the same way as SAP Business. 

 

↑ Top 

2.11 Item Master Data Setup 

Path 

Stock Management → Item Master Data 

When setting up Item Master Data within SAP Business One, the following fields 

are used by the ProcessForce: 

 Form Header 

o Unit Price – this value within this field is defaulted onto the Bill of 

Materials and Manufacturing Order, and is used for finance 

transactions 

o Item Group – to use License plate functions a specific Item Group 

code is required and added within the General Settings ProcessForce 

→ License Tab 



 

o Sales Item, Stock Item, Purchase Item, Fixed Assets Item - not 

checked in combination with Phantom Item - not checked for 

CoProduct production General Settings 

When using license plates, ProcessForce will automatically create a licence plate 

number and add this record to the Item Master, with the Item Group code as 

defined. 

 General Tab 

o Phantom Item - to be checked to define a phantom item within the Bill 

of Material 

o Issue Method - to define and Item Number as manual or back flush 

within the Bill of Materials and the Manufacturing Order 

o Serial and Batch Numbers - to utilise Batch Template, Serial Template 

Definition function 

 Planning Tab 

o Procurement Method - Make or Buy values are used within Bill of 

Materials and Manufacturing Order components 

 Right click navigation 

o Production → Item Details → Item Details 

o Production → Bill of Materials → Bill of Materials 



 

2.12 Batch Template, Serial Template Definition 

Here you can configure the default format of the 

batch number generator for creating batch and 

serial numbers during the receipt of Purchase and 

Production Orders. This information makes a 

traceability and a batch and serial management 

process much easier. You can set a number 

generating template that contains important 

information, e.g. date, time, item number or prefix. 
 

Path 

Administration → Setup → Stock 
Management → Batch Template Definition 

Here you can configure the format of the serial 

number generator for creating serial numbers. 
 

Path 

Administration → Setup → Stock 
Management → Serial Template Definition 

 

On this page:  

 Batch/Serial Template 

Allocation 

o General level 

o Item Group level 

o Item level 

 Defining Batch Template 

o Example 1: Date 

o Example 2: Date 

and Time 

o Example 3: 

Adding prefix 

o Example 4: 

Embedding Item 

number 

o Example 5: 

Incremental batch 

number starting 

with 5 zeros, and 

maximum length 

of 6 

o Example 6: Using 

a specific value 

from a document 

in Batch 

generation 

template 

o Example 7: 

Current date + 

shelf interval 

 HANA 

Studio – 

test 

 Batch 

Template 

formula 

 Defining Serial Template 

 



 

2.12.1 Batch/Serial Template Allocation 

The Batch Template form is used to define the batch template number for 

products that are batch traceable. The formula is based on TSQL statements, 

therefore providing a very flexible batch number creation. 

 

 

Batch templates (as well as Serial templates) can be set on three different levels:  

 general - for all batch traced Items 

 for Item Group 

 for a specific Item 

If a template is not specified for a specific level, a template from a level above is 

used. 

General level 

Path 

Administration → System Initialization → General Settings → ProcessForce tab → 
Inventory tab 



 

 

You can use Batch Number generated at MOR option. To do this check Batch 

Number generated at MOR checkbox and choose one of the options. When 

choosing one of the Status options, batch will be generated on appropriate status 

change or on creation of a Manufacturing Order with specified status. 

Note that when Batch Number generated at MOR option is checked, it is not 

possible to use Classification and MOR Number options on a Batch Template. 

Update 

Usage of %MORDN% parameter when Batch Number generated at MOR option is 

checked will be possible in ProcessForce from official release of 9.20 PL06 R1 

version. 

Item Group level 

Path 

Administration → Setup → Inventory → Item Groups → ProcessForce tab 

When checkboxes are unchecked it is possible to set a Batch or Serial template 

for an Item Group. 

When checkboxes are checked, General Settings Batch or Serial template is 

used. 



 

 

Item level 

Path 

Stock Management → Item Details → Batch Details tab 

When checkboxes are unchecked it is possible to set a Batch or Serial template 

for an Item. 

When checkboxes are checked, Item Group Settings Batch or Serial template is 

used. 



 

 

↑ Top 

2.12.2 Defining Batch Template 

It is possible to define a Batch Template as a distribution number or a Batch 

Template assigned for suppliers. To do that, pick a desired category (Dist 

Number or Suppl Batch tab). 

 



 

It is possible to define a Serial Number Template as a distribution number, a 

number for manufacturing items or as a Lot Number. To do that, pick a desired 

category (Dist Number, Manufacturing or Lot Number tab). 

 

When adding a new Batch/Serial template the date and counter fields are 

defaulted as follows: 

 Date = yyyy-MM-dd i.e. year-month-day 

 Time = hh:mm:ss i.e hours:minutes:seconds 

 Counter = 1. This is the starting value of the counter, it will increase starting 

with this value 

 Maximum batch number = 32 characters, as per SAP Business One. 

Note that Formula field is planned for 255 signs. Longer formulas will not work 

properly. You can use own databases procedure and scalar-valued functions. 

 

How to reach Batch Number Transaction Report from Goods Receipt PO 

Right click on Goods Receipt PO form: 



 

 

↑ Top 

Example 1: Date 

 Select the date function 

 To string another element of data enter + sign 

When working on ProcessForce on SAP HANA, please use || instead of + to string 

elements of a template 

 To enter text or other symbols enter the value between ‘ and ‘ 

 Select the counter function 

 Press the validate formula function to check the batch template syntax 

 Press OK. 



 

 

↑ Top 

Example 2: Date and Time 

 Select the date function 

 To string another element of data enter + sign 

When working on ProcessForce on SAP HANA, please use || instead of + to string 

elements of a template 

 Select the counter function 

 After the date format add : separator hh = hours, : separator mm = minutes 

 Press the validate formula function to check the batch template syntax 

 Press OK. 



 

 

↑ Top 

Example 3: Adding prefix  

 To enter text or other symbols as a prefix to the batch number use ‘ value ‘ = 
‘PF’ 

 To string another element of data enter + sign 

When working on ProcessForce on SAP HANA, please use || instead of + to string 

elements of a template 

 Select the date function 

 To string another element of data enter + sign 

 Select the counter function 

 Press the validate formula function to check the batch template syntax 

 Press OK 



 

 

↑ Top 

Example 4: Embedding Item number 

 To add the two first letters of the item number 

o enter left, 

o followed by ( 

o select the item code function 

o followed by a , 

o followed by the number of item code digits 

o followed by ) 

 To string another element of data enter + sign 

When working on ProcessForce on SAP HANA, please use || instead of + to string 

elements of a template 

 Select the date function 

 To string another element of data enter + sign 

 Select the counter function 

 Press the validate formula function to check the batch template syntax 

 Press OK 



 

 

↑ Top 

Example 5: Incremental batch number starting with 5 zeros, and maximum 

length of 6  

 Select the date function 

 To string another element of data enter + sign 

When working on ProcessForce on SAP HANA, please use || instead of + to string 

elements of a template 

 To add an increasing number starting with 5 leading zeros 

o enter right, 

o followed by ( 

o enter five zeros 

o followed by a , 

o followed by length of the total batch number 

o followed by ) 

 To string another element of data enter + sign 

 Select the counter function 

 Press the validate formula function to check the batch template syntax 



 

 Press OK 

 

↑ Top 

Example 6: Using a specific value from a document in Batch generation 

template 

You can use other that specified in Batch Template form field to be incorporated 

in a Batch template. In this example a warehouse value is used. Batch template 

generation is not suitable for this but we can set User Defined Values for 

Classification field to incorporate a warehouse value into the batch name. 

1. Create a new query in Query Generator (Tools → Queries → Query 
Generator), type in $[PDN1,WhsCode] (the name of the warehouse field) in 

Select field. 

 

 



 

How to check a field name? Click to check 

a) go to View → System Information and check the option (or click Ctrl + Shift 
+ I): 

 

b) point the field with a cursor – the name of the field will be displayed in 

System Messages Log: 

 



 

 



 

Click Execute and then Save in new window: 

 
Choose the name and Query Category and click Save: 

 

2. Click Classification field on Goods Receipt PO and go to Tools → 

Customization Tools → User-Defined Values - Setup: 



 

 

Choose previously created query, set other values and click Update. 

3. From now on Classification field will be set on Whse value on every change 

on Whse field. Now if you would you use Classification in Batch Template, a 

value for warehouse will be incorporated in the template. 

The same way you can set values from different field in the classification field 

and use it in a batch template. 

Example 7: Current date + shelf interval 

The following formula allows to generate a batch name with current date + shelf 

life time added. 

 



 

SAP HANA Studio – test 

To use the query for a specific Item use the following data: 

SELECT cast(ADD_DAYS(TO_DATE(CURRENT_DATE), (SELECT TO_INTEGER 

(RTRIM (T0."U_ShelfTime", 'd'))  

FROM "@CT_PF_OIDT" T0 WHERE T0."U_ItemCode" = 'your item code')) as 

NVARCHAR(36)) FROM DUMMY 

Batch Template formula 

The whole query result has to be converted/cast as text: 

cast(ADD_DAYS(TO_DATE(CURRENT_DATE), (SELECT TO_INTEGER (RTRIM 

(T0."U_ShelfTime", 'd')) FROM "@CT_PF_OIDT" T0 WHERE 

T0."U_ItemCode" = %ItemCode%)) as NVARCHAR(36)) 

 

The result of the formula has to be text value (NVARCHAR type, 36 characters; it 

is performed by using "cast" command).  

↑ Top 

2.12.3 Defining Serial Template 

Serial Template defining process looks the same as Batch Template defining 

process shown in examples above. 

2.13 Properties 

This form allows the user to define a specific 

property – physical and chemical characteristics, 

e.g. colour. 

The corresponding groups and subgroups can also 

be defined for example physical and colour. 

A list of valid values may also be defined from the 

reference library for example colour has valid values 

of yellow, blue, red and green. 

Checking the Quality Control Testing box implies 

that the Item Property will be used during the QC 

testing process. 

 

On this page 

 Item Properties 

 Item Property Groups 

 Property Reference 

Library 

 Properties assigning 

o Item Details 

o Batch Master 

Data 

 

 



 

2.13.1 Item Properties 

Path 

Administration → Setup → Item Details → Item Properties 

 

↑ Top 

2.13.2 Item Property Groups 

Path 

Administration → Setup → Item Details → Item Property Groups 

This form allows the user to define a property group and its details.  

You can define a name, a code and remarks for a specific property group. 

For every group, a number of subgroups with its own name, code and remarks 

can be defined. 

For example physical, with sub-groups of form and colour. 



 

 

↑ Top 

2.13.3 Property Reference Library 

Path 

Administration → Setup → Item Details → Property Reference Library 

This form allows the user to create a library of valid values to be used in 

conjunction with properties. 

These valid values, can be available for a single property type or for several 

property types, relating to items, resources, operations and operation inputs and 

outputs. 

 

↑ Top 



 

2.13.4 Properties assigning 

Item Details 

Once created property can be assign to an item in Item Details form, Properties 

tab. By clicking a second column and than a circle displayed within a field, a 

property can be chosen: 

 

A chosen item group can be assigned to a specific type of a document by 

checking a proper check-box: 

 



 

Batch Master Data 

Path 

Stock Management → Item Management → Batches → Batch Master Data 

Predefined properties can be assign to a specific batch of a product. 

 

↑ Top 

2.14 Item Classifications 

The Item Classification function allows the user to 

define specific classification with its name and code, 

for example corrosive, toxic, and nontoxic. 

Classifications can be grouped. 

 

On this page:  

 Item Classifications 

 Item Classification Groups 

 Item Classification 

assigning 

 

 



 

2.14.1 Item Classifications 

Path 

Administration → Setup → Item Details → Item Classification 

In this form you can define a specific classification. You can also choose on what 

kind of documents a specific classification can be used (by checking a 

corresponding check-box). 

 

↑ Top 

2.14.2 Item Classification Groups 

Path 

Administration → Setup → Item Details → Item Classification Groups 

The Item Classification Group function allows the user to create groups of item 

classifications for example EU Classifications. 

 

↑ Top 



 

2.14.3 Item Classification assigning 

Once created classification can be assign to an item in Item Details form, 

Classifications tab. By clicking a second column and and than a circle displayed 

within a field, a classification may be chosen: 

 

A chosen classification can be assigned to a specific type of a document by 

checking a proper check-box: 

 

↑ Top 



 

2.15 Phrases 

The Item Phrase form allows the user to define a 

specific phrase. Safety or Risk Phrases contain 

information about e.g. special transport and storage 

requirements or hazards. Phrases are defined in 

specific regulation e.g. EU Risk and Safety Phrases. 

ProcessForce Item Phrases functionality is also 

useful in creating a Material Safety Data Sheet for a 

specific item. 

 

On this page 

 Item Phrases 

 Item Phrase Groups 

 Item Phrase Group 

assigning 

 Item Phrase assigning 

 

2.15.1 Item Phrases 

Path 

Administration > Setup > Item Details > Item Phrases 

You can choose on what kind of document a specific Item Phrase can be used 

(by checking a corresponding check-box). 

 

↑ Top 



 

2.15.2 Item Phrase Groups 

Path 

Administration > Setup > Item Details > Item Phrase Group 

The Item Phrase Group functions allow the user to create groups of standard 

phrases, for example EU Risk and EU Safety Phrases. 

 

↑ Top 

2.15.3 Item Phrase Group assigning 

Path 

Administration > Setup > Item Details > Item Phrases 

The user can assign an Item Phrase Group to an Item Phrase by clicking a 

Group field and than a circle displayed within the field and choosing a group: 

 

↑ Top 



 

2.15.4 Item Phrase assigning 

Path 

Inventory → Item Details → Phrases tab 

Once created phrase may be assign to an item in Item Details form, Phrases tab. 

By clicking a second column and and than a circle displayed within a field, a 

proper phrase may be chosen: 

 

A chosen phrase may be assigned to a specific type of a document by checking 

a proper check-box 

 

↑ Top 



 

2.16 Item Groups 

The Item Group function allows the user to create 

groups of similar products, for example acids, 

solvents, boxes, and bottles. A higher level is 

available too: groups of groups. 

 

On this page:  

 Item Groups 

 Item Group Groups 

 Item Group assigning 

 Item Group Group 

assigning 

 

2.16.1 Item Groups 

Path 

Administration > Setup > Item Details > Item Groups 

 

↑ Top 

2.16.2 Item Group Groups 

Path 

Administration > Setup > Item Details > Item Group Groups 



 

The Item Group Group function allows user to define a grouping of a grouping, 

which is used to group similar sub-sets of items together, to aid in reporting and 

analysis. 

For example an item can belong to the group boxes and another grouping 

packaging. 

 

↑ Top 

2.16.3 Item Group assigning 

A once created item group can be assign to an item in Item Details form, Groups 

tab. By clicking a second column and than a circle displayed within a field, a 

proper Item Group can be chosen: 

 

A chosen group can be assigned to a specific type of a document by checking a 

proper check-box: 



 

 

↑ Top 

2.16.4 Item Group Group assigning 

A once created item group group can be assign to an Item Group. By clicking a 

group field and then a circle displayed within a field, a proper Item Group Group 

can be assigned: 

 

↑ Top 



 

2.17 Item Texts 

The Item Text functions allow the user to define a 

set of standard texts that are used to describe the 

item. 

For example define hazard instructions, safety text 

and cleaning information in case of a product 

spillage. You can specify on what kind of document 

specific Item Text will be used by checking 

corresponding check-box. 

 

On this page:  

 Item Texts 

 Item Text Groups 

 Item Text assigning 

 

2.17.1 Item Texts 

Path 

Administration > Setup > Item Details > Item Texts 

 

↑ Top 

2.17.2 Item Text Groups 

Path 

Administration > Setup > Item Details > Item Text Groups 



 

The Item Text Group function allows the user to define a Item Text Group, which 

is used to group similar item texts together. 

 

↑ Top 

2.17.3 Item Text assigning 

A once created item text can be assign to an item in Item Details form, Texts tab. 

By clicking a second column and than a circle displayed within a field, a proper 

Item text can be chosen: 

 

A chosen text can be assigned to a specific type of a document by checking a 

proper check-box. 

↑ Top 



 

2.18 MSDS, Labels and Documentation 

2.18.1 Compliance Data 

Industries which sell their products both locally and 

internationally have to provide their customers with 

documents such as Material Safety Data Sheet 

(MSDS) in a applicable language as supporting 

documentation for shipping. 

Using a combination of the forms listed below MSDS 

master data can be defined. 

 Classification 

 Phrases 

 Texts 

 Groups 

 Properties 

 

On this page:  

 Compliance Data 

 Configuration 

 Example 

 

2.18.2 Configuration 

 Within Company Details > Basic Initialization Tab, check the Multi-Language 

Support field: 

 



 

Within View > Indicator Display, select Translatable Fields 

 

↑ Top 

2.18.3 Example 

Phrases form is used to define the EU Phrases lists. The code is the same in all 

countries but the name is different for each languages. Data source: 

http://schoolscout24.de/cgi-bin/rsp/rspinput.cgi 

Czech R1 Výbušný v suchém stavu. 

Dansk R1 Eksplosiv i tør tilstand. 

Dutch R1 In droge toestand ontplofbaar. 
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http://schoolscout24.de/cgi-bin/rsp/rspinput.cgi


 

2.19 Substitute Items 

Path 

Main Menu > Stock Management > Substitutes 

It is possible to assign a replacement for any Item. If a specific Item is not 

currently available in Warehouses, it can be replaced by a Substitute assign to it. 

It is possible to set following settings for a Substitute: 

 Parent Item Revision 

 Item to be a Substitute 

 Revision for Item to be a Substitute 

 Time constraints for a Substitute validity 

 Ratio – value expressed in decimal setting a ratio of replacement, e.g.: 

1.00 = 100% 

0.5 = 50% 

1.50 = 150% 

 

2.19.1 Item Master Data context menu 

You can also reach Substitutes form from Item Master Data context menu: 



 

 

2.19.2 Usage 

You can change a specific Item for its Substitute on Pick Order by using Choose 

From List option for an Item: 
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2.20 Yield Master Data 

The default planned Yield % value is added on the Item Details form. 

When he Item Detail record is created the Yield % value is set to 0.00. 

If Yield % is not used within the Bill of Material, check the Ignore Yield field. 

 



 

If the item is a Parent item, the default Yield % value is copied to the Bill of 

Materials form header and if the Item is added to the Items, Coproducts and 

Scrap tab, this value is copied to the Yield field within the grid. 

If the Ignore Yield field is checked then the Yield field within the Items, 

Coproducts and Scrap tabs will be set to 100.00. 

These Yield values can be changed if required. 
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2.21 Country of Origin 

Country of Origin is the country of manufacture, 

production, or growth where the product comes 

from, and is used extensively to support Country of 

Origin labelling (COOL), traceability and specific 

ingredients in a Customers recipe. 

To support this process, the associated master data 

are defined on the Item Details form. 

 

On this page:  

 Origins Tab 

 Batch Creation 

 Batch Record 

 Batch Selection 

 

 

Path: 

Inventory > Item Details > Origins tab 



 

2.21.1 Origins Tab 

 

You can choose one default country of origin and a number of alternative 

countries. 

With two button you can either copy a set of assigned countries from another 

Item Details record or clear already in-putted on the tab data. 
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2.21.2 Batch Creation 

During the Goods Receipt PO process, the default Country of Origin is added to 

the batch/lot record, and if necessary can be overridden to one of the alternative 

origins. 

To do this, choose an Item line on Goods Receipt, right click and choose 

Generate Batches option. 



 

 

When you choose an Item line, in Created Batches table go to Origin column. 

The value in it is default country chosen on Item Details form for the Item (check 

the previous section). On clicking magnifier symbol, a list of defined for the Item 

alternative countries is open. You can choose one of the values instead of the 

default one. 
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2.21.3 Batch Record 

 

The Origin is displayed on Additional Batch Details header. From here you can 

also change it to one of the alternatives defined in Item Details form. 

↑ Top 



 

2.21.4 Batch Selection 

When picking a Batch, Origin column is also displayed: 
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